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Introduction

Thank you for using Mill Mouse.

Mill Mouse controls mouse with eye tracking by Tobii Eye Tracker 4C or other devices.

You can move the 

pointer to where you are 

looking at.

You can click when you 

keep gazing at the same 

place or close eyes.

6



Features

 Support scroll operations

Mill Mouse supports scroll operations on the start menu, Web browsers, etc. You can 

scroll up by looking at the top of them and scroll down by looking at the bottom.

 Adjust against the involuntary shaking of eyes

Mill Mouse controls the mouse pointer not to be protruded from the frames of the 

buttons or other objects in order to make it easier to click them.

OK
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Features

 Support operations on User Account Control dialog

Mill Mouse also makes User Account Control dialog clickable by eye tracking, which 

appeared when you install apps or run apps as administrator.
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System requirements

Any combination of the following is required to use Mill Mouse:

 Eye and head tracking

Device OS Software

Tobii Eye Tracker 5
Windows 11,

Windows 10
Tobii Experience
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System requirements

(Continued)

 Eye tracking

Device OS Software

Tobii Eye Tracker 4C
Windows 10,

Windows 8.1,

Windows 7

Tobii Experience (Windows 10 only)

or

Tobii Eye Tracking Core Software

Tobii EyeX,

SteelSeries Sentry

Windows 10,

Windows 8.1,

Windows 7

Tobii Eye Tracking Core Software

Irisbond Duo
Windows 10,

Windows 8.1,

Windows 7

Irisbond Duo Drivers

EyeTech TM5
Windows 10,

Windows 8.1,

Windows 7

(No additional software required) 10



System requirements

(Continued)

 Head tracking

Device OS Software

TrackIR 5
Windows 10,

Windows 8.1,

Windows 7

OptiTrack Camera SDK

and

TrackIR Software

SmartNav 4
Windows 8,

Windows 7

OptiTrack Camera SDK

and

TrackIR Software

OpenTrack supported 

devices

Windows 11,

Windows 10,

Windows 8.1,

Windows 7

OpenTrack
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System requirements

(Continued)

 Head and facial expression tracking

Device OS Software

Built-in camera,

Webcam

Windows 11,

Windows 10,

Windows 8.1

VSeeFace

or

OpenSeeFace

iPhone, iPad with A12 

Bionic chip or later
－

waidayo or VTube Studio

or Facemotion3d or iFacialMocap 

or Live Link Face

Android phone, tablet －
VTube Studio

or

MeowFace

※ You can control the Windows PC with Mill Mouse installed by head tracking, using the smartphone or 

tablet camera. It does not make the smartphone or tablet itself controllable by head tracking.
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Guide to click action

You can select the input method in the settings of Mill Mouse from the following.

1. Click when you keep gazing at the same place

2. Click when you close your eyes

3. Click when you press button on game controller

4. Click when you speak into a microphone

5. Use head tracking

6. Use facial expression tracking

The default setting is 1. This guide is based on 1.

For the usage when you select 2, please change the description of “keep gazing” 

to “close eyes” in this guide. Similarly, please change the description to

“press button on game controller while gazing” for 3, 

“speak into a microphone while gazing” for 4,

“change your head pose while gazing” for 5, and

“raise your eyebrows while gazing” or “open/close your mouth while gazing” for 6.
13



Installation

Please extract the ZIP file of Mill Mouse to any location.

Mill Mouse folder and the following 2 items will be extracted.

※ .exe or .pdf is not displayed in some cases. 

Mill_Mouse_830.exe Installer

UserGuide.pdf This file
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Installation

Run Mill_Mouse_830.exe.

If the SmartScreen like following is displayed, click ‘More Info’ and ‘Run anyway’.

※ If you have installed Mill Mouse, Publisher will be displayed as topolo-Z.
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Installation

Click Yes on the User Account Control dialog.

※ If you have installed Mill Mouse, Publisher will be displayed as topolo-Z.

※ If you are using a standard account on Windows, you will need to enter the administrator password.
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Installation

Click Next once or twice.

If you have installed Mill Mouse, 

this screen will be skipped.

17



Installation

Click Install and Finish.

To complete the installation of Mill Mouse, sign out from Windows once and sign 

in again.
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Installing Tobii Experience

If you want to use Tobii Eye Tracker 5 but have not yet installed Tobii Experience, 

please install it with the following steps.

1. Access the following URL.

https://gaming.tobii.com/getstarted/?bundle=tobii-et5

2. Scroll down the screen a little. Click ‘DOWNLOAD DRIVER’ to download the 

installer and run it.

3. Connect Tobii Eye Tracker 5 to your PC.

4. Click         icon in the notification area of the taskbar.

5. The Tobii Experience window will open. Click the gear icon in the upper right 

corner, click ‘Set up display’, and follow the instructions on the screen to 

make the settings.

19
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Installing Tobii Core Software

If you want to use Tobii Eye Tracker 4C, Tobii EyeX, or SteelSeries Sentry but have 

not yet installed Tobii Eye Tracking Core Software, please download and install it 

from the following URL.

https://gaming.tobii.com/getstarted/?bundle=tobii-core&autodownload=true

20
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Installing Irisbond Duo Drivers

If you want to use Irisbond Duo but have not yet installed Irisbond Duo Drivers, 

please access the following URL, click Download of Drivers, and install it.

https://www.irisbond.com/en/support-service/downloads/
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Installing OptiTrack Camera SDK

If you want to use TrackIR 5 or SmartNav 4 but have not yet installed OptiTrack Camera 
SDK, please access the following URL.
https://www.optitrack.com/support/downloads?cat=developer-tools

Click Download for Camera SDK, open the ‘Choose your Version’ drop-down list, scroll 
down, choose ‘Camera SDK 2.3.7’, click Download, and run it.

After running it and clicking Install, if the following dialog appears, click No to not 
install OptiTrack_USB_Drivers_x64. Then follow the instructions on the screen to install 
the OptiTrack Camera SDK.

Additionally, if you have not yet installed TrackIR Software, please access the following 
URL, click Download, and install it.
https://www.trackir.com/downloads/

Change the setting described on page 69 or 70 of this guide after launching Mill Mouse.

22
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Installing OpenTrack

If you want to use OpenTrack, please install it with the following steps.

1. Access the following URL.

https://github.com/opentrack/opentrack/releases

2. Download opentrack-xxx-setup.exe under Assets and install it.

3. Run OpenTrack and select the device you want use for Input.

4. Select ‘freetrack 2.0 Enhanced’ for Output, click the icon to the right of it, 

select ‘Enable both’ or ‘Use freetrack, disable TrackIR’ for ‘Select interface’, 

and press the OK button.

5. Press the Start button.

23
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Installing VSeeFace

If you want to use VSeeFace, please install it with the following steps.

1. Access the following URL and click Download to download the ZIP file.
https://www.vseeface.icu/#download

2. Extract the downloaded ZIP file to any location.

3. Run VSeeFace.exe in the extracted folder.

4. Proceed through the tutorial, select Camera and click Start.

5. Click ‘Settings’ > ‘General settings’ and check ‘Face tracking’. Scroll down the 
settings screen and check ‘Send data with VMC protocol’.

6. Enable ‘Mirror motion’. This setting is not required, but enabling it allows you 
to move the mouse pointer more intuitively.

7. If you want to use ‘Click when you close your eyes’ in Mill Mouse, Click 
‘Settings’ > ‘Expression settings’ and check ‘Enable eye blinking’ in VSeeFace.

8. After launching Mill Mouse, configure the settings described on pages 71-75 of 
this guide. If you want to use ‘Click when you open your mouth’ or ‘Click 
when you close your mouth’ in Mill Mouse, Click ‘Settings’ > ‘Expression 
settings’ and check ‘Enable mouth tracking’ in VSeeFace.

24
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Installing OpenSeeFace

If you want to use OpenSeeFace and have not yet downloaded either 

OpenSeeFace or VSeeFace, download OpenSeeFace-vxxx.zip under Assets from 

the following URL and extract the downloaded ZIP file to any location.

https://github.com/emilianavt/OpenSeeFace/releases

After launching Mill Mouse, configure the settings described on pages 71-75 of this 

guide.

※ OpenSeeFace is embedded in VSeeFace, so if you have already downloaded VSeeFace, you do not 

need to download OpenSeeFace from the above URL.

25
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Installing waidayo

If you want to use waidayo, please install it with the following steps.

1. Open the App Store on your iPhone or iPad, search for waidayo, and tap Get to 
install it.

2. Open waidayo. Turn your iPhone or iPad to portrait orientation and tap         icon 
on the upper left side.

3. On the ‘General’ tab, set ‘Auto Device Search’ to ON. Tap the ‘Face Tracking’ 
tab and tap ‘Face Position + Rotation’ or ‘Face Rotation Only’ in ‘Face 
Tracking Mode’. A small circle will appear for the tapped item.

4. On the ‘Face Tracking’ tab, set ‘Mirroring’ to OFF. This setting is not required, 
but setting it OFF allows you to move the mouse pointer more intuitively.

5. Connect your iPhone or iPad to a Wi-Fi network. Connect your Windows PC 
with Mill Mouse installed to the same Wi-Fi network.

6. After launching Mill Mouse on your Windows PC, configure the settings 
described on pages 71-75 of this guide.

7. If the mouse pointer does not move with head tracking, turn ‘Auto Device 
Search’ to OFF and then ON again on the ‘General’ tab of waidayo.

26
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Installing VTube Studio

If you want to use VTube Studio, please install it with the following steps.

1. If you have an iPhone or iPad, open the App Store, search for VTube Studio, 

and tap Get to install it.

If you have an Android phone or tablet, open the Play Store, search for VTube 

Studio, and tap Install to install it.

2. Open VTube Studio. Tap the gear icon on the left side. 

3. Scroll down to the bottom of the configuration screen, set ‘3rd Party PC Clients’

to Activate.

4. Connect your iPhone/iPad or Android phone/tablet to a Wi-Fi network. Connect

your Windows PC with Mill Mouse installed to the same Wi-Fi network.

5. After launching Mill Mouse on your Windows PC, configure the settings 

described on pages 71-75 of this guide.
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Installing Live Link Face

If you want to use Live Link Face, please install it with the following steps.

1. Open the App Store on your iPhone or iPad, search for Live Link Face, and tap 

Get to install it.

2. Connect your iPhone or iPad to a Wi-Fi network. Connect your Windows PC 

with Mill Mouse installed to the same Wi-Fi network.

3. Open Live Link Face. When you are prompted to select a capture mode, tap ‘Live 

Link (ARKit)’ and then ‘Continue’.

4. Tap the gear icon on the upper left side. Tap ‘Head Rotation’ to enable it.

5. Tap ‘Live Link’ under ‘STREAMING’. Tap ‘Add Target’, enter the IP address of your 

Windows PC with Mill Mouse installed, and tap ‘Add’ on the upper right side. Tap 

‘Settings’ on the upper left side, and tap ‘Done’ on the upper right side.

6. After launching Mill Mouse on your Windows PC, configure the settings 

described on pages 71-75 of this guide. Set the ‘Port’ of Mill Mouse to 11111.
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Installing MeowFace

If you want to use MeowFace, please install it with the following steps.

1. Open the Play Store on your Android phone or tablet, search for MeowFace, 

and tap Install to install it.

2. Open MeowFace.

3. If you want to use ‘Click when you close your eyes’ in Mill Mouse, scroll down 

on the MeowFace screen, tap the number to the right of ‘Weight’ for 

‘eyeBlink_L’, and change the value to 2.0. Similarly, change the ‘Weight’ for 

‘eyeBlink_R’ to 2.0.

4. Connect your Android phone or tablet to a Wi-Fi network. Connect your 

Windows PC with Mill Mouse installed to the same Wi-Fi network.

5. After launching Mill Mouse on your Windows PC, configure the settings 

described on pages 71-75 of this guide.
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How to useHow to use
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Launch Mill Mouse

Connect Tobii Eye Tracker 4C or other eye/head tracking device to your PC.

From Start menu, click Mill Mouse folder > Mill Mouse.

Mill Mouse starts up and the window will be appeared at the top left of the 

desktop screen.

※ The number of buttons on the right side of the window depends on the size of the desktop screen.

※ If the taskbar is located at the top or the left on Windows 10, Windows 8.1, or Windows 7, the window 

will be appeared at the bottom right.
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Basic functions

The each functions are as follows:

1 2 3 4 5 6

① Change click actions

② Zoom to apps

③ Switch magnifier

④ Switch touch keyboard

⑤ Perform shortcuts and show next/previous

⑥ Expand/collapse window

32



Change click actions

You can change the click action performed when you keep gazing at the same 

place. Each time you look at the button on the far left of the window, the action 

will be changed.

You can change between seven types of actions by default: Click, Double click, Drag, 

Right click, Tap, Choose, and No click.

You can change the settings of Mill Mouse to use only certain click actions. 

※ Tap action is not supported on Windows 7.

※ If 'Switch primary and secondary buttons' is enabled for the mouse, it will be left click rather than 

right click.
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To change click actions frequently

By changing the click action to Choose, you can select the action each time you 

keep gazing at the same place.

①Change to Choose.

②When you keep gazing at the

same place, the action panels

will be displayed around.

  ③When you keep gazing at 

any panel, that action will 

be done. If you do not want 

to action anything, keep 

gazing at anywhere other 

than the panels or close 

your eyes.

※ If you keep gazing on the touch keyboard or the on-screen keyboard, the click action will be done 

without displaying the action panels.
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Zoom on apps

You can zoom the Web browsers or some other apps by using Stretch or Shrink on 

the second from the left of the window.

①Change to Stretch or Shrink.

②If you keep gazing at the same 

place on the Web browser or 

other apps, the zoom action

will be done. 35

③To stop zooming, switch to the 

click action on the left side of the 

window of Mill Mouse.

※ Some apps may not support zoom action.



Switch magnifier

By using Magnifier on the third from the left of the window, you can zoom in on 

the desktop screen before the click action.

①Look at Magnifier to turn it on.

②If you keep gazing at the same place,

its surroundings will be zoomed in.

③If you keep gazing at the same place while

zooming, the click action will be done. 36

④To turn Magnifier off, look at 

Magnifier again.

※ On Windows 7, Magnifier is only available when Windows Aero is enabled.



Switch touch keyboard

You can switch show/hide of the touch keyboard by looking at Keyboard on the 

fourth from the left of the window.

You can also use the on-screen keyboard instead of the touch keyboard by 

changing the settings of Mill Mouse.

※ On Windows 7 Home Basic, the touch keyboard is not available.
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Perform shortcuts

If you look at any button on the right side of the window, you can perform 

shortcuts assigned to them, such as Ctrl + X, Ctrl + V, and so on.

You can change the settings of which shortcuts are displayed in the window.

※ On Windows 8.1 or Windows 7, shortcut icons are not displayed.
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Show next/previous shortcuts

You can set up to 20 shortcuts. The window displays some of them to fit on the 

desktop screen. By looking at the buttons on the second from the right of the 

window, you can display the rest of them.
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Expand/collapse window

You can collapse or expand the window by looking at the button on the far right 

of the window.

※ You can adjust the width of the window by dragging the right edge of the button on the far right of 

the window.
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Unhide window

By default, the window will be hidden after a while.

To unhide, look at the upper left corner of the desktop screen.

If it does not work, try to look at the outer frame of the monitor.

※ If the taskbar is located at the top or the left on Windows 10, Windows 8.1, or Windows 7, look at the 

bottom right corner of the screen.

※ Whether to automatically hide the window and where to re-display it can be changed by settings. 
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Exit Mill Mouse

To exit Mill Mouse, look at the X button at the top right of the window.
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Settings of Mill MouseSettings of Mill Mouse
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Settings – Open settings dialog

If the shortcut of ‘Settings of Mill Mouse’ is displayed in the window, you can open 

the dialog to change the settings of Mill Mouse by looking at it.

If ‘Settings of Mill Mouse’ is not displayed, keep gazing at the title bar of the 

window to display the menu. Then, keep gazing at Settings on the menu. After 

that, the settings dialog will open.

※ The menu may not be displayed while playing a game in full screen.
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Settings – Speed adjustments

You can adjust the speeds on the Speed tab of the settings dialog.

45



Settings – Speed adjustments

Depending on the setting of ‘Input method’ on the Input tab described later, the 

meaning of ‘Click interval’ on the Speed tab changes as follows:

‘Input method’ on Input tab Meaning of ‘Click interval’ on Speed tab

If you select ‘Click when you keep gazing at 

the same place’

How long time you keep gazing at the same 

place in order to perform the click action

If you select ‘Click when you close your eyes’
How long time you keep closing your eyes 

in order to perform the click action

If you select ‘Click when you press button on 

game controller’
No effect

If you select ‘Click when you speak into a 

microphone’

How often to perform the click action when 

you continue speaking

If you select ‘Use head tracking’ No effect 46



Settings – Input method

You can change the input method on the Input tab of the settings dialog.
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Settings – Input method

If you check ‘Click when you keep gazing at the same place’,  the click action will 

be performed each time you keep gazing at the same place. If you do not want to 

click any more when you keep gazing at the same place, change the action on the 

button on the far left of the Mill Mouse window to ‘No click’.

①Change the click action.

②The click action will be performed each 

time you keep gazing at the same place.

③If you want to stop the click action, 

change it to ‘No click’.
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Settings – Input method

You can set it to automatically change to ‘No click’ after gazing at the same place 

and clicking.

①Press the gear icon button to the

right of ‘Click when you keep 

gazing at the same place’.
②A dialog will be displayed. Check ‘Change 

action to no click after clicking’ and press 

OK.
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Settings – Input method

(Continued)

If you check ‘Change action to no click after clicking’, the action on the button 

on the far left of Mill Mouse window will automatically change to ‘No click’ after 

you keep gazing at the same place and perform the click action once.

①Change the click action.

②Keep gazing at the same place and 

perform the click action once.

③It will automatically 

change to ‘No click’.
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Settings – Input method

(Continued)

If you check ‘Change action to no click after clicking’, as an exception, the action

will not automatically change to ‘No click’ after you keep gazing at any of the

following windows and click on it:

 Mill Mouse main window, settings dialog, or separate windows

 Touch keyboard, or on-screen keyboard

 A game screen where you move the camera with mouse operations
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Settings – Input method

If you check ‘Click when you close your eyes’ on the Input tab, the click action 

will be performed when you close one or both eyes. The setting of ‘Eye used for 

gazing’ determines which eye’s closure will perform the click action.

‘Eye used for gazing’ Which eye’s closure will perform the click action

If you select ‘Always both eyes’ Left or right eye closure

If you select ‘One or both eyes’ Both eyes closure

If you select ‘Left eye’ Left eye closure

If you select ‘Right eye’ Right eye closure

※ If you use VSeeFace, iPhone/iPad, or Android phone/tablet, the above corresponds to the left and 

right eyes of the avatar.

※ If ‘Link eye blinks’ is enabled in VSeeFace, select ‘One or both eyes’ for ‘Eye used for gazing’ in 

Mill Mouse.
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Settings – Input method

You can change the click action that will be performed when you close your eyes.

①Check ‘Click when you close your 

eyes’ and press the gear icon button 

to the right.
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Settings – Input method

(Continued)

For ‘Always both eyes’ For other than ‘Always both eyes’

②If you have selected ‘Always both eyes’ for ‘Eye used for gazing’, a dialog 

will be displayed to select the action for the left eye and the right eye.

If you have selected something other than ‘Always both eyes’ for ‘Eye used 

for gazing’, a dialog will be displayed to select only one action.
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Settings – Input method

(Continued)

③Select a click action to perform when you

close your eyes.

If you select Default as the click action, the 

click action on the button on the far left of

the Mill Mouse window will be performed

when you close your eyes.

If you select Default and also check ‘Change

action to no click after clicking’, the action 

on the button on the far left of Mill Mouse

window will automatically change to ‘No

click’ after you close your eyes and perform

the click action once.

※ If you check ‘Change action to no click after clicking’, there are exceptions as described on page 51 of 

this guide.
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Settings – Input method

(Continued)

④If you select ‘Select a key...’ in ③, you 

can set the keys to be pressed when you 

close your eyes. A new dialog will open, 

select the keys to be pressed and press 

the OK button.
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Settings – Input method

(Continued)

Depending on the ‘Action’ setting in the dialog ④, the key inputs when you close 

your eyes will change as follows:

‘Action’ Key inputs

If you select ‘Press the keys’
When you close your eyes, the keys will be 

pressed and then immediately released.

If you select ‘Hold down the keys’ and 

uncheck ‘Release the keys when you open 

your eyes’

When you close your eyes once, the keys 

will remain pressed. When you open your 

eyes, the keys will remain pressed. When 

you close your eyes again, the keys will be 

released.

If you select ‘Hold down the keys’ and 

check ‘Release the keys when you open 

your eyes’

While you close your eyes, the keys will 

remain pressed. When you open your 

eyes, the keys will be released.
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Settings – Input method

(Continued)

⑤Set the ‘Click interval’ on the Speed tab as 

required. This is the setting for how long 

you must keep your eyes closed before 

performing the click action.
‘Default’ is the same interval as on page 45 

of this guide. If you select ‘Custom’, you 

can change the interval from the default.

⑥Press OK.
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Settings – Input method

(Continued)

If you set it to press keys when you close your eyes, you can temporarily switch 

the operation to perform a click action when you close your eyes.

On the screen on page 107 of this guide, select the ‘Click with eyes closed’ 

shortcut in ‘Available shortcuts’ and press   button to move it to ‘Current 

shortcuts’. The ‘Click with eyes closed’ shortcut will be displayed on the screen.

If you look at the ‘Click with eyes closed’ shortcut and then close your eyes, the 

button color will be changed. After that, each time you close your eyes, the click 

action on the button on the far left of the Mill Mouse window will be performed.

To stop the click action and return to pressing keys, look at the ‘Click with eyes 

closed’ shortcut and close your eyes again.
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Settings – Input method

If you check ‘Click when you speak into a microphone’, a click action will be 

performed when you speak any word or phrase into the microphone. Additionally, 

you can use voice commands to perform click actions only when you speak 

specific phrases into the microphone.

①Check ‘Click when you speak into a

microphone’ and press the gear icon

button to the right.

※ You can adjust the microphone sensitivity in Control Panel > Sound > Recording tab > Default Device > 

Properties > Levels tab.
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Settings – Input method

(Continued)

②Dialog will be displayed. If you want to use

voice commands, check ‘Use voice commands’,

otherwise uncheck it.

③If you use voice commands, a list of saved phrases

and actions will be displayed. The ‘Phrase’ column

represents the phrase you speak into the micro-

phone, and the ‘Action’ column represents the

action to be performed when you speak that phrase.

By default, 4 types of phrases are saved:

“Double click”, “Drag”, “Left click”, and “Right click”.

   For example, speaking “Left click” performs a click.

※ If you use voice commands, the action will be performed with a short delay after you speak into the 

microphone.

※ By default, speaking “Drag” starts a drag, and speaking “Drag” again performs a drop.
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Settings – Input method

(Continued)

④You can add up to 100 voice command 

phrases.

Press ‘+’ button to add a phrase.

⑤A dialog will be displayed. Enter the ‘Phrase’,

select the ‘Action’, and press OK.

In addition to mouse actions, you can also set a 

shortcut key. In this example, speaking “Start” 

will enter the Win key.
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Settings – Input method

(Continued)

⑥The phrase will be added to the list.

Press the OK or Apply button to enable

the added phrase.
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Settings – Input method

If you are using Windows in English, Simplified Chinese, Traditional Chinese, 

French, German, Japanese, or Spanish, Mill Mouse will use Windows built-in 

speech recognition engine to recognize the language you speak into the microphone.

If you are using Windows in Catalan, Danish, Dutch, Finnish, Italian, Korean, 

Norwegian (Bokmål), Polish, Portuguese, Russian, Swedish, or Valencian, you can 

have the language you speak into the microphone recognized by installing 

Microsoft Speech Platform Runtime and the corresponding language data additionally. 

Please see the next page for installation instructions.

If you are using Windows in Arabic, Czech, Hindi, Telugu, Turkish, or Vietnamese, 

you can have the language you speak into the microphone recognized by installing 

Vosk language data additionally. Please see pages 66-67 for installation instructions.

Mill Mouse does not support voice commands in languages other than those listed 

above. If you are using Windows in a language other than those listed above, hold 

down the Windows logo key and press R on your keyboard to open the Run dialog, 

enter ‘control.exe "C:\Windows\System32\Speech\SpeechUX\sapi.cpl" speech’ in 

Open, click OK, and then select the speech recognition engine in Language on the 

Speech Recognition tab.
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Settings – Input method

To install Microsoft Speech Platform Runtime, click the Download button from  

the following URL, then download and install both files with the same name 

SpeechPlatformRuntime.msi.

https://www.microsoft.com/en-us/download/details.aspx?id=27225

Next, click the Download button from the following URL, then download and 

install the MSSpeech_SR_xx-XX_TELE.msi that corresponds to your language.

https://www.microsoft.com/en-us/download/details.aspx?id=27224

The above steps will make Mill Mouse use the installed speech recognition engine 

to recognize the language you speak into the microphone.

If you perform the above steps in a Korean environment, the Phrase of the 

Mill Mouse voice command must be written in Hangul, not Latin characters.

Also, if you perform the above steps in Russian environment, the Phrase of the 

Mill Mouse voice command must be written in Cyrillic characters, not Latin 

characters.

※ On Windows 7, please download and install Version 10.2 of SpeechPlatformRuntime.msi and 

MSSpeech_SR_xx-XX_TELE.msi instead of Version 11 above.
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Settings – Input method

If you are using Windows in Arabic, Czech, Hindi, Telugu, Turkish, or Vietnamese, 

an additional item ‘Use Vosk for speech recognition’ will be displayed at the 

bottom of the screen described on page 61 of this guide.

Follow the steps below to install Vosk language data and have it recognize the 

language you speak into the microphone. The following example uses the Hindi 

interface.

①Check ‘Use voice commands’.

②Check ‘Use Vosk for speech

recognition’.

③Press Download button. The language 

data will begin downloading, so please 

wait a moment.
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Settings – Input method

(Continued for Vosk)

④A message will appear when the 

download is complete. Press OK.

⑤Press OK or Apply. Mill Mouse will now

be able to recognize the language you

speak into the microphone. 67



Settings – Input method

‘Use head tracking’ is available with Tobii Eye Tracker 5.

If you check ‘Use head tracking’, you can set 

whether to click when you move your head, 

or to move the pointer with head tracking.

※ If you use Tobii Eye Tracker 4C, ‘Use head tracking’ is available with Tobii Eye Tracking Core Software 

version 2.13.1.
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Settings – Input method

If you are using TrackIR 5, the items on the Input tab of the settings dialog will be 

different than if you were using other devices. To use with TrackClip Pro, change 

‘Tracking target’ to ‘TrackClip Pro’.

It  can also be used with a 

commercial reflective material

instead of TrackClip or TrackClip 

Pro. To use with a reflective 

material, change ‘Tracking target’

to ‘Reflective marker’.

You can move the mouse pointer

by moving the reflective material

up, down, left or right in front 

of the TrackIR 5 camera.

※ Reflective material may have adhesive,

but it cannot be applied to skin such 

as the forehead. 69
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Settings – Input method

If you are using SmartNav 4, the items on the Input tab of the settings dialog will 

be different than if you were using other devices. Change ‘Tracking target’ to 

‘Reflective marker’.

If you have external switches 

connected to the SmartNav 4, 

the left switch will act as a left 

click and the right switch will 

act as a right click.
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Settings – Input method

If you use VSeeFace, OpenSeeFace, iPhone/iPad, or Android phone/tablet, please set 

it up from the gear icon to the right of ‘Use head tracking’.

①Press the gear icon button to the 

right of ‘Use head tracking’.
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Settings – Input method

(Continued)
②A dialog will be displayed. Select ‘Preferred

device or app’.

   If you primarily use an eye tracking device

and additionally use facial expression

tracking, select ‘Eye tracking device’ for

‘Preferred device or app’.

   If you do not use an eye tracking device, 

select an item other than ‘Eye tracking 

device’ for ‘Preferred device or app’.

③Check ‘Receive messages from other apps’,

select ‘Type’, and press OK.
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Settings – Input method

(Continued)

If you check ‘Receive messages from other apps’, select ‘Type’ as follows according 

to the app you use: 

App you use ‘Type’

VSeeFace or waidayo Select ‘VMC Protocol’

OpenSeeFace Select ‘OpenSeeFace’

VTube Studio Select ‘VTube Studio’

Facemotion3d Select ‘Facemotion3d’

iFacialMocap Select ‘iFacialMocap’

Live Link Face Select ‘Live Link Face’

MeowFace
Select ‘VTube Studio’ or ‘Facemotion3d’

or ‘iFacialMocap’
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Settings – Input method

(Continued)

If you select ‘OpenSeeFace’ for ‘Type’, the setting items are different than if you 

select any other type. Please set ‘Location of facetracker’ and Camera.

Click Browse and select Binary\facetracker.exe in the 

location where you extracted the OpenSeeFace ZIP file, 

or select 

VSeeFace_Data\StreamingAssets\Binary\facetracker.exe 

in the location where you extracted the VSeeFace ZIP file.

Select the built-in camera or webcam you 

want to use.
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Settings – Input method

(Continued)

‘Facial expression tracking’ allows you to perform a click action when you raise 

your eyebrows or open or close your mouth.

If you set it to ‘Click when you raise your 

eyebrows’, ‘Click when you open your mouth’ or 

‘Click when you close your mouth’, the click 

action on the button on the far left of the Mill 

Mouse window will be performed.

If you set it to ‘Drag only while your eyebrows 

are raised’, ‘Drag only while your mouth is 

open’ or ‘Drag only while your mouth is closed’, 

the drag will be performed regardless of the 

selection on the button on the far left of the 

Mill Mouse window.

※ If you select ‘VMC Protocol’, you will not be able to 

perform the click action when you raise your eyebrows.

※ If you use ‘Click when you speak into a microphone’ or voice commands as input method, set ‘Mouth’ 

to ‘(None)’ to avoid tracking your mouth movements while you are speaking.

75



Settings – Game controller

On the Controller tab of the settings dialog, you can map specific click actions to 

the buttons on your game controller.
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Settings – Game controller

If you map a click action to a button on your game controller, the mapped click 

action will be performed when you press that button.

①Check ‘Click when you press button on game 

controller’.

②Select the click action to be mapped to the button 

number. For Xbox controllers,

   ‘1’ corresponds to A button,

   ‘2’ corresponds to B button,

   ‘3’ corresponds to X button, and

   ‘4’ corresponds to Y button.

   If you map Default, pressing that button on the 

game controller will perform a click action on the 

button on the far left of the Mill Mouse window.
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Settings – Game controller

If you map a key to a button on your game controller, the mapped key will be 

entered when you press that button.

①Check ‘Click when you press button on 

game controller’.

②Select

‘Select a key...’ 

from the list.

③Dialog will be displayed.

Select the key to map.

④Press OK. In this example, the Space key

will be entered by pressing button 1.
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Settings – Game controller

‘←’, ‘→’, ‘↑’, ‘↓’ correspond to the directional pad on your game controller or 

the left thumbstick on your Xbox controller. You can map ‘Move pointer’ to them.

If you map ‘Move pointer’ to 

them, you can move the mouse 

pointer slightly with the direc-

tional pad or left thumbstick in 

addition to moving it with eye/ 

head tracking.
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Settings – Pause

On the Pause tab of the settings dialog, you can change whether to pause the 

eye/head tracking when you use the physical mouse and the shortcut key to 

pause.

If you are using an external 

switch that act as a mouse, 

uncheck ‘Pause Mill Mouse 

when you move the physical 

mouse’ and ‘Pause Mill Mouse 

when you click a physical 

mouse button’.

※ If the option ‘Press the axes/buttons

on the game controller when you 

click a physical mouse button’ on 

page 143 of this guide is enabled, 

Mill Mouse will not pause even if 

you click a physical mouse button.
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Settings – Sound

On the Sound tab of the settings dialog, you can change whether to use click 

sound and the voice to read texts aloud.

※ To use non-English voice on Windows 7, please install Microsoft Speech Platform Runtime and
Text-to-Speech engine data additionally.
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Settings – Scroll

On the Scroll tab of the settings dialog, you can change whether to use scrolling 

feature and the lines to scroll each time.

※ Even if you enable the scrolling feature, it will not scroll while you hold down the Ctrl or Shift key.
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Settings – Click action

You can change to use only certain click actions on the Click tab of the settings 

dialog.

Check the actions to use.

Uncheck the actions not to use.
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Settings – Click action

You can increase the number of click action buttons on the far left of the window 

up to 4 buttons.

①Select the action you want to use 

as another button.

②Press     button several times to move 

it under ‘Button 2’.
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Settings – Click action

(Continued)

③The button will be displayed in the window and you can use it as 

well as the button on the far left.
   By setting ‘Button 3’ and ‘Button 4’ in the same way in ②, you can 

increase the number of click action buttons up to 4 buttons.
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Settings – Click action

You can assign shortcut keys to click actions.

①Select a click 

action.

②Press the button 

to edit.

③Dialog will be displayed.

Select the key to assign.

④Press OK. In this example, the click 

action will be changed to Click by 
      pressing the C key.

※ Depending on the key you select, you may not be able to assign it. In that case, you will not be able 
to press OK button in ④, so select another key.
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Settings – Subaction

On the Subaction tab of the settings dialog, you can change whether to show 

Stretch/Shrink or Magnifier button in the window, the zoom increments of the 

magnifier, whether to flip the pointer, and whether to use Gaze Trace.

Gaze Trace is a feature of Tobii Experience 

and Tobii Eye Tracking Core Software. Gaze 

Trace enables a bubble to show where you 

are looking.

※ ‘Use Gaze Trace’ is only available if you have Tobii Experience or Tobii Eye Tracking Core Software 

installed.
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Settings – Subaction

If you check ‘Flip the pointer at the edge of the screen’, the mouse pointer will 

be flipped when it is at the right or bottom edge of the desktop screen. This helps 

you to prevent losing track of the mouse pointer.

Flipping the mouse pointer keeps it visible at 

all times, preventing it from disappearing off-

screen and getting lost.

※ Only the pointers built into Windows can be flipped. If you are using any other app that changes the 

look of the pointer, you will not be able to flip it with that look preserved.
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Settings – Keyboard

On the Keyboard tab of the settings dialog, you can change whether to show 

keyboard button in the window and whether to use the touch keyboard or the  

on-screen keyboard. You can also set it up to drag with a physical keyboard key.
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If you check ‘Drag when you hold down the physical 

keyboard key’, you can select which key to use 

for dragging.

The drag will remain as long as you hold down 

the key, and the drop will be performed when 

you release the key.



Settings – Keyboard

If you have installed Tobii Dynavox Windows Control, you can select Tobii Dynavox 

Windows Control as ‘Keyboard type’.

※ To use the taskbar or shortcuts in Tobii Dynavox Windows Control that appear on the left or right side 

of the desktop screen, run Tobii Dynavox Windows Control separately from Mill Mouse.
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Settings – Shortcuts

You can change the shortcuts to be displayed in the window from the Shortcuts 

tab of the settings dialog.

You can set up to 20 shortcuts.
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Settings – Shortcuts

86 types of shortcut keys listed at the end of this guide are available as shortcuts.

In addition to the shortcut keys, the following 14 types of shortcuts for Mill Mouse 

are also available.

 Settings of Mill Mouse

 Calibration

 Move Mill Mouse

 Move Mill Mouse up

 Move Mill Mouse down

 Minimize Mill Mouse

 Hide Mill Mouse

 Stop Mill Mouse

 Hide pointer

 Move pointer

 Click with eyes closed

 Scroll

 Lock separate windows

 Exit Mill Mouse

※ ‘Minimize Mill Mouse’ is a shortcut to minimize the Mill Mouse main window and separate windows to 

the taskbar. ‘Hide Mill Mouse’ is a shortcut to hide only the Mill Mouse main window.

※ ‘Move Mill Mouse up’ and ‘Move Mill Mouse down’ will be changed to ‘Move Mill Mouse left’ and ‘Move 

Mill Mouse right’ when the window of Mill Mouse is displayed vertically.

※ ‘Scroll’ is a shortcut to enable or disable ‘Use scrolling’ described on page 82 of this guide.
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Settings – Shortcuts

You can assign shortcut keys to 14 types of shortcuts for Mill Mouse.

①Select a shortcut

for Mill Mouse.

②Press the button

to edit.

③Dialog will be displayed.

Select the key to assign.

④Press OK. In this example, the settings 

dialog of Mill Mouse will open by 

pressing Ctrl + F1.

※ Depending on the key you select, you may not be able to assign it. In that case, you will not be able 
to press OK button in ④, so select another key.
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Settings – Add custom shortcuts

You can add up to 100 custom shortcut keys.

①Press ‘+’ button.
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Settings – Add custom shortcuts

(Continued)

②Dialog will be displayed. Set the 

name and select ‘Shortcut key’.

③Select the key.

④Set the color and the icon 

of the shortcut button on 

the View tab.

※ For Name, set a short string to be displayed in the window as the following ⑧.
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Settings – Add custom shortcuts

(Continued)

⑤Set the ‘Click interval’ on the Speed tab as 

required. This is the setting for how long 

you must look at this shortcut button before 

clicking it.

‘Default’ is the same interval as on page 45 

of this guide. If you select ‘Custom’, you 

can change the interval from the default.

⑥Press OK.
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Settings – Add custom shortcuts

(Continued)

⑦It will be added to ‘Available 

shortcuts’. Press     button to 

move it to ‘Current shortcuts’.
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Settings – Add custom shortcuts

(Continued) ⑧It will be displayed in the window 

and can be performed in the same 

way as other shortcuts.

⑨If you have selected ‘Hold down the keys’ as the Action 

in ③, once you press the button, the shortcut key will 

remain pressed and the button color will be changed.
If you press the button again, the keys will be released 

and the button color will be restored.

※ If you have selected ‘Press the keys repeatedly’ in ③, the keys will be entered repeatedly.
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Settings – Press keys only when gazing

If you check ‘Press the keys only when you gaze at the shortcut button’ on page 

95 of this guide, the keys will be pressed only when you gaze at the shortcut 

button regardless of the input method setting on page 47 of this guide. Depending 

on the ‘Action’ setting, the key inputs will change as follows:

‘Action’ Key inputs

If you select ‘Press the keys’
When you gaze at the shortcut button, the 
keys will be pressed and then immediately 
released.

If you select ‘Press the keys repeatedly’ and 
uncheck ‘Release the keys when you look 
away from the shortcut button’

When you gaze at the shortcut button once, 
the keys will start to be pressed 
repeatedly. When you look away from the 
shortcut button, the keys will continue to 
repeat. When you gaze  at the shortcut 
button again, the keys will stop repeating.

If you select ‘Press the keys repeatedly’ and 
check ‘Release the keys when you look away 
from the shortcut button’

While you gaze at the shortcut button, the 
keys will be pressed repeatedly. When you 
look away from the shortcut button, the 
keys will stop repeating.
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Settings – Press keys only when gazing

(Continued)

‘Action’ Key inputs

If you select ‘Hold down the keys’ and 

uncheck ‘Release the keys when you look 

away from the shortcut button’

When you gaze at the shortcut button once, 

the keys will remain pressed. When you 

look away from the shortcut button, the 

keys will remain pressed. When you gaze  

at the shortcut button again, the keys will 

be released.

If you select ‘Hold down the keys’ and check 

‘Release the keys when you look away from 

the shortcut button’

While you gaze at the shortcut button, the 

keys will remain pressed. When you look 

away from the shortcut button, the keys 

will be released.
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Settings – Add custom texts

You can also set custom texts for input to the text editors or other apps, or 

reading aloud.

①Press ‘+’ button.

②Dialog will be displayed. Set 

the name and select Text.

③Enter the custom 

text, select the 

action and press OK.

※ For Name, set a short string to be displayed in the window as the following ⑤.
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Settings – Add custom texts

(Continued)

④It will be added to ‘Available 

shortcuts’. Press     button to 

move it to ‘Current shortcuts’.
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Settings – Add custom texts

(Continued)

⑤The button will be displayed in the window.

   If you have checked ‘Input text’ in ③, press 

the button with the text editor open to input 

the text you have set.
If you have checked ‘Hear text read aloud’ 

in ③, press the button to read the text you 

have set aloud.
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Settings – Shortcuts to launch other apps

You can also add shortcuts to launch other apps.

①Press ‘+’ button.

②Dialog will be displayed. Set 

the name and select App.

③Set the path of the app 

to launch in Target and 

press OK.

※ For Name, set a short string to be displayed in the window as the following ⑤.
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Settings – Shortcuts to launch other apps

(Continued)

④It will be added to ‘Available 

shortcuts’. Press     button to 

move it to ‘Current shortcuts’.
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Settings – Shortcuts to launch other apps

(Continued)

⑤The button will be displayed in the window.

If you press the button, the app set in ③ will 

launch.

If you have set the path of image, audio, or 
video file to Target in ③, press the button to 

launch the app associated with the file type.
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Settings – Separate windows

You can also show the shortcuts in separate windows. You can set up to 100 

shortcuts.

①Select a shortcut from ‘Current 

shortcuts’ which you want to show 

in separate window.

②Press     button several times to move 

it under ‘Separate windows’.
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Settings – Separate windows

(Continued)
③The shortcut button appears in a 

separate window on the desktop

screen.

④You can move it on the desktop screen 

by dragging inside. You can change the 

size by dragging the edges.
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Settings – Separate windows

(Continued)

You can lock separate windows so that they cannot be dragged.

On the screen on page 107 of this guide, select the ‘Lock separate windows’ 

shortcut in ‘Available shortcuts’ and press   button to move it to ‘Current 

shortcuts’. The ‘Lock separate windows’ shortcut will be displayed on the screen.

If you keep gazing at the ‘Lock separate windows’ shortcut, the button color will 

be changed and all separate windows will become un-draggable.

To make them draggable, keep gazing at the ‘Lock separate windows’ shortcut 

again.
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Settings – Window display

On the Window tab of the settings dialog, you can change the window display 

location, whether to automatically hide or fade the window, and the color of the 

window.
‘Default location of the main window on 

screen’ allows you to change the location 

where the window will reappear when it 

is hidden.

If you uncheck ‘Automatically hide the 

window’, the window position next time 

started will be the last end position.

※ If high contrast is enabled, the color can not be changed.
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Settings – Window display

Pressing the gear icon button to the right of Color will open a new dialog that 

allows you to change the colors of the ‘Selected click action border’ and 

‘Shortcut button while holding down the keys’.

①Press the gear icon button to 

the right of Color.

※ If high contrast is enabled, the color can not be changed.
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Settings – Window display

(Continued)

②Dialog will be displayed. Press the 

‘Edit color’ button to change the 

color. The default color is white.

   After changing the color, press OK.

③The color of the corresponding item will 

change. In this example, the ‘Selected 

click action border’ has been changed to 

red, so the border of the ‘Click’ is lined 

in red. Also, the ‘Shortcut button while 

holding down the keys’ has been changed 

to blue, so the shortcut button with the 

key held down is filled in blue.

※ If you change the color of the ‘Shortcut button while holding down the keys’, the colors of the 

Magnifier, ‘Move pointer’, ‘Click with eyes closed’, ‘Scroll’, ‘Lock separate windows’, ‘Stop Mill Mouse’ and 

the Pause button in simple mode will also change.
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Settings – Startup

On the Startup tab of the settings dialog, you can change whether to automatically 

launch Mill Mouse when you sign-in to Windows, whether to terminate Tobii Experience 

or Tobii EyeX Interaction in the notification area of the taskbar, and the startup 

mode.
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Settings – Check for a new version

If you enable ‘Automatically check whether a new version is available after starting 

Mill Mouse’, it will automatically check for a new version via the internet when 

you launch Mill Mouse.

If a new version of Mill Mouse is available, the message below will appear. Click 

Yes to update.

※ It will not automatically check for a new version if Mill Mouse is running in simple mode.

※ It will not automatically check for a new version over metered connections on Windows 11, Windows 10, 

or Windows 8.1.

114



Settings – Check for a new version

(Continued)

Click Yes on the User Account Control dialog.

※ If you are using a standard account on Windows, you will need to enter the administrator password. 115



Settings – Check for a new version

(Continued)

A new version of Mill Mouse will be installed automatically. Eye/head tracking will 

temporarily stop during installation.

Once the installation is complete, the new version of Mill Mouse will automatically 

launch and you can resume eye/head tracking.

At the end of the installation, click OK when the message below appears.
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Settings – Simple mode

If you set the startup mode to Simple described on page 113 of this guide, Mill Mouse
will run in simple mode. In simple mode, the available functions and display items 
are limited. It has the following differences from normal mode.

 In simple mode, only clicks are performed when you keep gazing at the same 
place. Any action other than clicking, such as double clicking or dragging, is 
not possible.

 In simple mode, only the Pause button is displayed on the desktop screen. 
Neither the main window of Mill Mouse nor separate windows are displayed.

You can move the Pause button on the desktop screen by dragging inside. You can 
also change the size of the Pause button by dragging the edges. However, you can 
not perform drags by eye/head tracking in simple mode, so you need to use a 
physical mouse to drag it.
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Settings – Simple mode

To pause clicks in simple mode, keep gazing at the Pause button. Then the button 

color will be changed, and clicking will not be performed even if you keep gazing 

at the same place other than the Pause button.

To cancel the pause, keep gazing at the Pause button again.
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Settings – Simple mode

To switch back from simple mode to normal mode, keep gazing at        icon in the 

notification area of the taskbar and select Settings from the menu displayed. 

Then the settings dialog will open. Go to the Startup tab as described on page 113

of this guide and change the startup mode to Normal.

If the icon is hidden, keep gazing at

to make it appear.
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Settings – Simple mode

To exit Mill Mouse while in simple mode, keep gazing at        icon in the notification

area of the taskbar and select Exit from the menu displayed.

Mill Mouse will be in simple mode the next time it starts.

If the icon is hidden, keep gazing at

to make it appear.
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Settings – Profile

On the Profile tab, you can save a set of Mill Mouse settings as a profile and 

switch between them. For example, you can save your preferred arrangement of 

shortcuts for a game as a profile in advance. Then, by switching to that profile 

just before playing the game, you can quickly rearrange the shortcuts as you have 

saved them.

①Press New or Copy.
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Settings – Profile

(Continued)

②A profile will be added to ‘Available 

Profiles’. Enter a name.

③Press ‘Switch profile’. Then Mill Mouse 

will restart and this settings dialog will

open again.
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Settings – Profile

(Continued)

④‘Current profile’ will change to the 

name you entered in ②.

⑤Select any tab such as ‘Shortcuts’ 

and set the settings you want to 

save as the current profile.
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Settings – Profile

(Continued)

⑥Select ‘(Default profile)’ and press 

‘Switch profile’. Then Mill Mouse will 

restart and the settings will be restored.

⑦After that, at any time you like, open this Profile 

tab again, select a profile from ‘Available profiles’, 

and press ‘Switch profile’ to switch to the saved 

settings.
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Settings – Profile

(Continued)

⑧You can set up a shortcut to switch 

profiles other than pressing the ‘Switch 

profile’ button described above.

The profile shortcuts are at the bottom 

of ‘Available shortcuts’ in the Shortcuts 

tab. By moving it to ‘Current shortcuts’ 

like other shortcuts, you can set up a 

shortcut to switch profiles.
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Other functionsOther functions
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Others – Calibration of eye tracking

You can open the calibration screen of the eye tracking from Calibration on the 

menu displayed when you keep gazing at the title bar of the window.

※ If you use Tobii Eye Tracker 4C, Tobii EyeX, or SteelSeries Sentry, it takes about 10 seconds from the 

menu selection until the calibration screen is displayed.
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Others – Calibration of eye tracking

If you are using Tobii Eye Tracker 5, Tobii Eye Tracker 4C, Tobii EyeX, or SteelSeries 

Sentry and have installed Tobii Dynavox Gaze Point, you can select whether to 

perform the calibration with Tobii Dynavox Gaze Point from the menu.

※ To customize the calibration settings of Tobii Dynavox Gaze Point, run Gaze Point Settings separately 

from Mill Mouse.

※ If you have installed Tobii Dynavox Windows Control, you can also select it from the menu.
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Others – Calibration of eye tracking

If you are using Irisbond Duo or EyeTech TM5, you can select the number of calibration 

points from the menu.

When you select it from the menu, a white circle will appear on the screen. Keep 

gazing at that circle to complete the calibration. To abort calibration, press the 

Esc key.

The greater the number of calibration points, the longer it takes to calibrate, but 

the more accurate the eye tracking will be.
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Others – Calibration of head tracking

If you are using head tracking, you can open the calibration screen of the head 

tracking from Calibration on the menu displayed when you keep gazing at the 

title bar of the window.

①This calibration screen will open. 

Keep facing forward for a few seconds.

②Calibration is complete when the 

bar appears all white.

The calibration screen will close 

automatically.

※ If you are using TrackIR 5 or SmartNav 4 with a reflective marker, you can also perform calibration on

the same screen as above.
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Others – Vertical window

Move the window of Mill Mouse to the left or right edge on the desktop 

screen to display it vertically. Move the vertical window to the upper or 

lower edge on the desktop screen to revert it to the horizontal window.

①Select Move on the menu.

②Keep gazing at the left or right 

edge on the desktop screen.

③The window of Mill Mouse will 

be displayed vertically.
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Others – Widgets

Keep gazing at the middle height of the left edge on the desktop screen to display 

the Widgets on Windows 11.

If it does not work, try to gaze at the outer frame of the monitor.

※ As an exception, if the taskbar alignment is set to left on Windows 11, nothing special will be happened.

※ Keep gazing at there on Windows 10, the Task View will be displayed.

※ Keep gazing at there on Windows 8.1, the list of recently used store apps will be displayed.

※ On Windows 7, Flip 3D will be used when Windows Aero is enabled.
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Others – Notification Center and Calendar

Keep gazing at the middle height of the right edge on the desktop screen to 

display the Notification Center and Calendar on Windows 11.

If it does not work, try to gaze at the outer frame of the monitor.

※ Keep gazing at there on Windows 10, the Action Center will be displayed.

※ Keep gazing at there on Windows 8.1, the Charm bar will be displayed.

※ Nothing special will be happened on Windows 7.
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Others – User Account Control

You can also click on the User Account Control dialog by eye tracking or head 

tracking, which appeared when you install apps or run apps as administrator.

At that time, the window of Mill Mouse will not be displayed.

※ However, if you are running Mill Mouse and OpenTrack or VSeeFace on the same PC, you can not 

operate the User Account Control dialog by head tracking.
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Others – Camera panning during games

While playing a game that you pan the camera by mouse operation, you can pan 

in the direction you are looking at by using Mill Mouse.

While playing such a game, you can change the click action performed when you 

keep gazing at the same place, by pressing the shortcut keys described on page 

86 of this guide.
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Others – Pointer movement during games

If you need to move the pointer while playing a game and it does not move where 

you are looking, use the ‘Move pointer’ shortcut. On the screen described on page 

107 of this guide, move the ‘Move pointer’ from ‘Available shortcuts’ to ‘Current 

shortcut’ to display that shortcut on the screen.

If you keep gazing at the ‘Move pointer’ shortcut, the button color will be 

changed and you will be able to move the pointer wherever you are looking.

To exit the pointer movement and return to the camera movement described 

above while playing the game, keep looking at the ‘Move pointer’ shortcut again.

For camera movement For pointer movement

※ The ‘Move pointer’ shortcut is only used during game play. The ‘Move pointer’ shortcut has no effect 

on the normal desktop screen.
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Others – Click action during games

When you start a game, the click action of Mill Mouse will automatically change 

to Click if all the following conditions are met.

 A click action other than ‘No click’ is used.

 No shortcut key is set for any click action.

 The ‘Move pointer’ shortcut described above is not being used, or is in a state 

for camera movement.

If you do not want to change to Click automatically, set a shortcut key of your 

choice by following the steps on page 86 of this guide.

The action will automatically change to Click.
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Others – Stop mouse control during games

You can also prevent the camera from moving with eye tracking while playing the

game.

On the Pause tab of the settings dialog described on page 80 of this guide, set

‘Action’ to ‘Pause mouse control only’. Then the name of ‘Stop Mill Mouse’

shortcut will change to ‘Stop mouse control’. Please set the ‘Stop mouse control’

shortcut as a separate window by following the steps on page 107 of this guide.

If you stop mouse control only, the pointer and in-game camera will no longer

move to where you are looking, and it will no longer click even if you keep gazing

at the same place. However, the exception is the shortcut buttons of Mill Mouse,

which you can click by gazing on them.
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Others – Game controller emulation

If you have installed ViGEmBus, you can select ‘ViGEmBus’ as the custom shortcut 

type described on page 95 of this guide.

By selecting ‘ViGEmBus’, you can set 

up the shortcut to emulate the 

thumbsticks and button presses on a 

game controller.

Furthermore, if you have installed 

vJoy, you can select ‘vJoy’. If you 

don’t have installed ViGEmBus, install  

ScpVBus in addition to vJoy and you 

will be able to select ‘vXbox’. If you 

want to play games that support Xbox 

controllers, ‘ViGEmBus’ or ‘vXbox’ is a 

better choice than ‘vJoy’.

※ If you want to use vXbox on Windows 7, please 

also install Microsoft Xbox 360 Accessories.

139

https://vigembusdriver.com/
https://sourceforge.net/projects/vjoystick/
https://github.com/shauleiz/ScpVBus/releases
https://archive.org/details/xbox-360-64-engwin-7
https://archive.org/details/xbox-360-64-engwin-7


Others – Game controller emulation

(Continued)

If you have installed ViGEmBus, the additional option ‘Select an axis/button...’ 

will be displayed as the action to perform when you close your eyes, as described 

on page 55 of this guide. 

By selecting this option, you can set up 

the action to emulate the thumbsticks  

and button presses on a game 

controller when you close your eyes.

If you have installed vJoy in addition to 

ViGEmBus, you can choose whether to 

use ViGEmBus or vJoy after selecting 

‘Select an axis/button...’. If you don’t 

have installed ViGEmBus, install  ScpVBus

in addition to vJoy and you will be 

able to select ‘vXbox’.
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Others – Game controller emulation

(Continued)

If you have installed ViGEmBus, the additional option ‘ViGEmBus’ will also be

displayed as an action for the voice command on page 62 of this guide.

By selecting this option, you can set

it to emulate the thumbsticks and

button presses on a game controller

when you speak a specific phrase

into the microphone.

Furthermore, if you have installed

vJoy, an additional option ‘vJoy’ will

also be displayed. If you don’t have

installed ViGEmBus, install ScpVBus

in addition to vJoy and an additional

option ‘vXbox’ will be displayed.
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Others – Game controller emulation

(Continued)

If you have installed ViGEmBus, the additional option ‘Select an axis/button...’ 

will also be displayed as an action for the facial expression tracking on page 75 of 

this guide.

By selecting this option, you can set 
up the action to emulate the 
thumbsticks  and button presses on 
a game controller when you raise 
your eyebrows or open or close your 
mouth.

If you have installed vJoy in addition 
to ViGEmBus, you can choose whether 
to use ViGEmBus or vJoy after 
selecting ‘Select an axis/button...’. 
If you don’t have installed ViGEmBus, 
install  ScpVBus in addition to vJoy 
and you will be able to select 
‘vXbox’.
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Others – Game controller emulation

(Continued)

If you have installed ViGEmBus, the additional item ‘Press the axes/buttons on 

the game controller when you click a physical mouse button’ will also be 

displayed at the lower part of the Click tab on page 83 of this guide.

By checking this item, you can set 

up thumbsticks and button presses 

via the ViGEmBus when you click a 

physical mouse button.

※ It does not disable input from a physical 

mouse. Both the physical mouse and the 

assigned action will be input.

①Check the checkbox and

select the mouse button.

②Press the button to edit. A new dialog will open, select the

ViGEmBus thumbstick or button to map to the mouse button.
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Others – Game controller emulation

(Continued)

If you have installed ViGEmBus, the additional item ‘Press the axes/buttons on 

the game controller when you press a physical keyboard key’ will also be 

displayed at the lower part of the Keyboard tab on page 89 of this guide.

By checking this item, you can set

up thumbsticks and button presses

via the ViGEmBus when you press a

physical keyboard key.

※ It does not disable input from a physical

keyboard. Both the physical keyboard and

the assigned action will be input.

①Check the checkbox and

select the key.

②Press the button to edit. A new dialog will open, select the 

ViGEmBus thumbstick or button to map to the key.
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Others – Game controller emulation

(Continued)

If you have installed ViGEmBus, the additional option ‘Select an axis/button...’

will also be displayed as an action to map to a button on a physical game

controller on page 77 of this guide.

By selecting this option, you can set

up thumbsticks and button presses

via the ViGEmBus when you press

buttons on a physical game controller.

※ If you check ‘Click when you press button 

on game controller’, the assigned action 

will be performed when you press a button 

on a physical game controller other than 

ViGEmBus, vJoy, or vXbox.

※ It does not disable input from a physical 

game controller. Both the physical game 

controller and the assigned action will be 

input.
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Others – Game controller emulation

(Continued)

The vJoy device number that Mill Mouse uses can be changed on the Controller 

tab of the Mill Mouse settings dialog.

If you have installed vJoy, the 

item ‘vJoy device number’ will 

be displayed.

The default is Auto. If it is set to 

Auto, Mill Mouse will use the 

lowest numbered available vJoy 

device.
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Others – Game controller emulation

Titan One or Titan Two allows you to provide controller input to the game 

consoles that Titan One or Titan Two supports. By connecting an HDMI video 

capture device separately from Titan One or Titan Two and displaying the game 

console screen on your PC monitor, you can play games with eye tracking.

USB

HDMI

USB

USB

HDMI

Monitor

Eye tracker

Windows PC

HDMI video

capture

Game console

Titan One 

or

 Titan Two

※ Titan One or Titan Two may not work on the latest game consoles. Author topolo-Z has not confirmed 

that it works on all game consoles.
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Others – Game controller emulation

(Continued)

To use Titan One, connect it to your PC and configure it to connect to your game 

console from Tools > Options in Gtuner Pro.

If you have the Gtuner Pro plugin screen open, please close it. Mill Mouse can not 

be used in conjunction with the Gtuner Pro plugin.

Launch Mill Mouse with Titan One connected to your PC. You can select ‘Titan 

One’ as the custom shortcut type described on page 95 of this guide. By selecting 

‘Titan One’, you can set up the shortcut that provides thumbstick and button 

press input to the game console.

If the button names displayed in the Mill Mouse settings dialog are different from 

those of your game console, please set the ‘Titan One output’ in the Controller 

tab of the Mill Mouse settings dialog to match your game console.

※ If you open the Gtuner Pro plugin screen while running Mill Mouse, the ‘Titan One’ shortcuts in Mill 

Mouse will not work. If this happens, close the Gtuner Pro plugin screen and reselect ‘Titan One 

output’ in the Controller tab of the Mill Mouse settings dialog. Then the shortcuts will work again.
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Others – Game controller emulation

(Continued)

To use Titan Two, first set up shortcuts on the Mill Mouse side by selecting 

‘Shortcut key’ as the type of custom shortcut on page 95 of this guide and setting 

up shortcuts that use key inputs, or selecting ‘ViGEmBus’ on page 139 of this 

guide and setting up shortcuts that emulate the thumbsticks and button presses 

on a game controller.

Next, launch Gtuner IV and open the ‘Input Translator’ tab. If only the ‘GTUNER 

GIT’ icon is displayed, click the icon, enter the ‘File Name’, and click ‘Create’.

If you set up shortcuts of type ‘Shortcut key’ in Mill Mouse, use the ‘Keyboard 

Mapping’ section in the ‘Input Translator’ tab of Gtuner IV to associate the keys 

you set for Mill Mouse shortcuts with the thumbsticks and buttons you use on your 

game console.

If you set up shortcuts of type ‘ViGEmBus’ in Mill Mouse, use the ‘Controller 

Remapper’ section in the ‘Input Translator’ tab of Gtuner IV to associate the 

thumbsticks and buttons you set for Mill Mouse shortcuts with the thumbsticks 

and buttons you use on your game console.
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Others – Game controller emulation

(Continued for Titan Two)

After making the association, select File > Save in Gtuner IV to save it to the file. 

Then, select File > ‘Install To’ > ‘Memory Slot X’ to store it in the memory slot on 

the Titan Two unit.

Next, open the ‘Device Memory Slots’ tab in Gtuner IV and click the memory slot 

number you stored to load it into the Titan Two unit.

Finally, select Tools > ‘KMG Capture’ in Gtuner IV, check ‘Keyboard’ or 

‘Gamepad/Joystick’, uncheck ‘Mouse’, and click ‘ENTER CAPTURE MODE’.

As a result, you can use Mill Mouse shortcuts to provide thumbstick and button 

press inputs to the game console.
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Others – Combination with physical mouse

It is also possible to use in combination with a physical mouse device.

If you operate the physical mouse device while using Mill Mouse, the eye/head 

tracking will be paused and the operation by the physical mouse will take 

precedence. 

After stopping the operation by the physical mouse and waiting for a few seconds,

you will be able to operate the mouse again with eye/head tracking.

In addition to the physical mouse, if you operate the right thumbstick of the Xbox 

controller, the eye/head tracking will be paused.

※ You can change the settings to pause when you operate the physical mouse or the right thumbstick of 

the Xbox controller.
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Others – Stop eye tracking

If you do not need eye/head tracking for a long time, such as for watching 

movies, you can stop eye/head tracking.

To stop eye/head tracking, look at ‘Stop Mill Mouse’ shortcut or Stop on the menu 

displayed when you keep gazing at the title bar of the window. If ‘Automatically 

hide the main window’ described on page 110 of this guide is enabled, the 

window will be hidden when you stop eye/head tracking.
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Others – Stop eye tracking

If you stop eye/head tracking from the ‘Stop Mill Mouse’ shortcut or Stop on the 

menu displayed when you keep gazing at the title bar of the window, unlike the 

physical mouse operation described above, the stop will not be canceled 

automatically.

You can cancel the stop by gazing at the ‘Stop Mill Mouse’ shortcut again.

If the window has been hidden since you stopped eye/head tracking, you can also 

cancel the stop by looking at the upper left corner of the desktop screen to 

make the window appear again.

※ If the taskbar is located at the top or the left on Windows 10, Windows 8.1, or Windows 7, look at the 

bottom right corner of the screen. However, if you have changed the ‘Default location of the main 

window on screen’ described on page 110 of this guide, look at that location.
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Others – Stop eye tracking

You can set the ‘Stop Mill Mouse’ shortcut as a separate window by following the 

steps on page 107 of this guide.

If you keep gazing at the ‘Stop Mill Mouse’ shortcut, the button color will be 

changed and eye/head tracking will stop.

You can cancel the stop by gazing at the ‘Stop Mill Mouse’ shortcut again.
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Others – Stop eye tracking

You can also stop eye/head tracking by voice command.

If you select ‘Shortcut for Mill Mouse’ as the voice command action described on 

page 62 of this guide, and select ‘Stop Mill Mouse’ or ‘Stop mouse control’ for 

Shortcut, eye/head tracking will stop when you speak the phrase you set into the 

microphone.

You can cancel the stop by speaking the same phrase again into the microphone.
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Others – Stop eye tracking

If you press Alt + Shift + M, eye/head tracking will be stopped.

The stop will not be canceled automatically.

To cancel the stop which was done by the above keys, press Alt + Shift + M again.

You can change the key combination on the Pause tab of the settings dialog as 

described on page 80 of this guide.
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Others – Hide mouse pointer

If you do not need the mouse pointer but need click action, such as for reading  

e-books, you can hide the mouse pointer.

To hide the mouse pointer, select ‘Hide pointer’ on the menu displayed when you 

keep gazing at the title bar of the window.

To unhide it, select ‘Hide pointer’ again.
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Others – Hide mouse pointer

If you check ‘Hide pointer after starting Mill Mouse’ on the Startup tab of the 

settings dialog, the mouse pointer will be hidden from the beginning the next 

time you start Mill Mouse.
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Others – Mill Mouse specific shortcut keys

You can adjust the speeds with the following shortcut keys.

 Speed of the mouse pointer

 Interval between starting to gaze and doing click operation

Alt + Shift + 1 Slow

Alt + Shift + 2 Fast

Alt + Shift + 3 Long

Alt + Shift + 4 Short
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Others – SwitchBot Plug Mini

In some countries or regions, including Canada, Japan, and the United States, you 

can set a shortcut to turn the SwitchBot Plug Mini on or off.

In some countries or regions, including 

Canada, Japan, and the United States, 

you can select ‘SwitchBot Plug Mini’ 

as the custom shortcut type described 

on page 95 of this guide.

Plug the SwitchBot Plug Mini device 

into a power outlet and turn on 

Bluetooth on your PC. You will then 

be able to set the ‘Unique identifier’ 

on the screen, so enter the Name and 

click OK.

※ SwitchBot Plug Mini shortcuts can only be used 

on Windows 11 or Windows 10.
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Others – SwitchBot Plug Mini

(Continued)

If you keep gazing at the SwitchBot Plug Mini shortcut you set up in the previous 

steps, the button color will be changed and the SwitchBot Plug Mini device will be 

turned on or off.

Off On
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Others – Supported languages

Besides English, Mill Mouse supports the following languages.
The words in the window of Mill Mouse are displayed according to the language 
settings of Windows.

 Afrikaans
 Arabic
 Bangla/Bengali
 Bosnian
 Bulgarian
 Catalan
 Chinese

(Simplified/Traditional)

 Croatian

 Czech
 Danish
 Dutch
 Estonian
 Finnish
 French
 German
 Greek
 Hebrew

 Hindi
 Hungarian
 Indonesian
 Italian
 Japanese
 Korean
 Malay
 Norwegian

(Bokmål)

 Polish
 Portuguese
 Romanian
 Russian
 Serbian

(Cyrillic/Latin)

 Slovak
 Slovenian
 Spanish

 Swedish
 Telugu
 Turkish
 Urdu
 Valencian
 Vietnamese

※ In the Arabic, Hebrew, or Urdu environment, the window is appeared at the top right or the bottom 
left of the desktop screen.

※ In the Spanish or Portuguese environment, some shortcut keys are changed, such as using Ctrl + G 
instead of Ctrl + S.

162



Others – High contrast

Mill Mouse supports high contrast.

The color scheme of the window of Mill Mouse follows the high contrast settings 

of Windows.

※ By default in Windows, you can enable or disable high contrast by pressing Left Shift + Left Alt + Print 

Screen keys.
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Tips – To enlarge buttons

If buttons are too small to operate, please change the settings with the following 

steps.

1. From the Start menu of Windows 11 or Windows 10, click the Settings icon.

2. System > Display > Change the percentage of ‘Scale & layout’.

3. If it is still too small, set a larger size as ‘Custom scaling’ in the advanced 

scaling settings. (In order to reflect custom scaling, you need to sign out from 

Windows and sign in again.)

※ On Windows 8.1 or Windows 7, please change the settings by the following steps.

1. Right click on the desktop screen > Click ‘Screen resolution’.

2. Click ‘Make text and other items larger or smaller’.

3. Change it to a larger size and click Apply.

4. Sign out from Windows and sign in again.
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Tips – Upgrading Tobii Core Software

If you face a problem after upgrading Tobii Eye Tracking Core Software to a new 

version, please try the clean installation as follows: ( The following steps are for people

familiar with Windows. Calibration profiles for the eye tracking will be deleted.)

1. Uninstall the Tobii Eye Tracking software from ‘Programs and Features’ in Control Panel.

2. With Tobii Eye Tracker 4C or other eye tracking device connected to your PC, open Device 
Manager and uninstall EyeChip in ‘Universal Serial Bus devices’. If EyeChip does not exist, 
uninstall the driver in ‘Eye Tracking Devices’.

3. Open Registry Editor and delete the following keys:

⚫ HKEY_CURRENT_USER\Software\Tobii

⚫ HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Tobii

4. Open File Explorer and delete the following folders:

⚫ %localappdata%\Tobii

⚫ %programdata%\Tobii

⚫ %programdata%\TetServer

5. Restart Windows.

6. Install a new version of Tobii Eye Tracking Core Software.

7. Calibrate the eye tracking.

!
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Tips – To use SSML or SAPI TTS XML

If you enable ‘Hear text read aloud’ as described on page 101 of this guide, you 

can write SSML or SAPI TTS XML in ‘Text’ as follows:

At the beginning of ‘Text’, write <speak> in SSML, or any XML tag in SAPI TTS XML. 

Change the value of xml:lang attribute in SSML according to your language.

SSML example

<speak version="1.0" 
 xmlns="http://www.w3.org/2001/10/synthesis"
xml:lang="en-US">

Hello<break time="300ms" />How are you?
</speak>

SAPI TTS XML 

example

<p>
Hello<silence msec="300" />How are you?
</p>
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Tips – To use swipe-based typing

Swipe-based typing is available on the touch keyboard in Windows 11 or Windows 10

(since October 2018 Update). Only some languages are supported.

To use swipe-based typing with Mill Mouse, please follow the steps below.

①Change to Drag

on Mill Mouse.

②Press Ctrl key on the 

touch keyboard.

③Keep gazing at the first 

letter until the pointer

icon changes to     .

④You can input the 

following letters 

continuously just

by looking briefly.
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Tips – To use 50-on keyboard layout

If you are using the Japanese IME on Windows 11, you can switch to the 50-on 

layout with the touch keyboard.

To switch to the 50-on layout, select         icon in the upper left corner of the 

touch keyboard > ‘Keyboard layout’ > ‘50-on’.

※ The 50-on layout is not available with the touch keyboard on Windows 10, Windows 8.1, or Windows 7.

※ The 50-on layout is not available with the on-screen keyboard.
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Tips – Remote control of other PCs

By using remote desktop software such as VNC, Parsec, or Moonlight, you can 

remotely control other PCs by eye/head tracking from a Windows PC with 

Mill Mouse installed.

However, there are the following functional limitations for other PCs that are 

remotely controlled.

 The scrolling feature on page 7 and page 82 of this guide is not available.

 The feature to prevent protrusion from the frames, described on page 7 of 

this guide, is not available.

 The feature ‘Hear text of the clicked item read aloud’ on page 81 of this guide 

is not available.

※ If you enable ‘Optimize mouse for remote desktop instead of games’ in Moonlight, please also enable 

‘Move pointer’ in Mill Mouse as described on page 136 of this guide.
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Tips – To use without eye/head tracking device

The ‘Click when you speak into a microphone’ on page 60 or the ‘Click when you 

press button on game controller’ on page 76 will work even without an eye/head 

tracking device.

Without an eye/head tracking device, mapping ‘Move pointer’ to the directional 

pad on your game controller or the left thumbstick on your Xbox controller (as 

described on page 79 of this guide) allows you to move the mouse pointer across 

the entire screen with the directional pad or left thumbstick.

However, without an eye/head tracking device, there are the following functional 

limitations.
 The click action of Choose on page 34 of this guide is not available.

 The settings of ‘Click when you keep gazing at the same place’, ‘Click when you close your 

eyes’, or ‘Eye used for gazing’ on page 47 of this guide do not work.

 The setting of ‘Press the keys only when you gaze at the shortcut button’ on page 99 of this 

guide does not work.

 The Calibration on page 127 of this guide is not available.

 The ‘Move pointer’ shortcut on page 136 is not available.

 The ‘Windows eye control’ shortcut on page 182 is not available.

 If the mouse pointer is not visible on the screen, such as while playing a game that you move 

the camera by mouse operation, you may not be able to click on the Mill Mouse main window 

or separate windows.

170



Windows eye controlWindows eye control
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Windows eye control – Settings

You can use Windows built-in eye control with Tobii Eye Tracker 5, Irisbond Duo, 

EyeTech TM5, TrackIR 5, OpenTrack, VSeeFace, OpenSeeFace, iPhone/iPad, or 

Android phone/tablet. To use it, follow the steps below to set it up.

1. Download the ZIP file of the sample driver provided by Microsoft from the 

following URL. 
https://github.com/MSREnable/GazeHid/raw/master/EyeGazeIoctl%20Driver.zip

2. Extract the downloaded ZIP file to any location such as the desktop.

※ A 64-bit environment of Windows 11 or Windows 10 (since Fall Creators Update) is required to use 

Windows built-in eye control through these steps.
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Windows eye control – Settings

(Continued)

3. Hold down the Windows logo key and press R on your keyboard.

4. The Run dialog will open. Enter ‘hdwwiz’ in Open and click OK.
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Windows eye control – Settings

(Continued)

5. Click Yes on the User Account Control dialog.

※ If you are using a standard account on Windows, you will need to enter the administrator password. 174



Windows eye control – Settings

(Continued)

6. ‘Add Hardware’ wizard will open. Click Next.

7. Select ‘Install the hardware that I manually select from a list (Advanced)’ and 

click Next.
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Windows eye control – Settings

(Continued)

8. Click Next and ‘Have Disk’.
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Windows eye control – Settings

(Continued)

9. Click Browse, select eyegazeioctl.inf in the location extracted in step 2, and 

click Open.

※ .inf is not displayed in some cases. 177



Windows eye control – Settings

(Continued)

10. Click OK and Next.
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Windows eye control – Settings

(Continued)

11. Click Next and Finish.
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Windows eye control – Settings

(Continued)

12. Launch Mill Mouse, open the settings dialog and go to the Shortcuts tab.

13. Select ‘Windows eye control’ 

near the bottom of ‘Available 

shortcuts’, press     button to 

move it to ‘Current shortcuts’, 

and click Close.

180



Windows eye control – Settings

(Continued)

14. ‘Windows eye control’ will be displayed in the window of Mill Mouse.

You are now set up to use Windows eye control.

You can delete the ZIP file downloaded in step 1 and the files extracted in step 2.
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Windows eye control – How to use

If you select ‘Windows eye control’ displayed in the window of Mill Mouse, the 

launchpad will appear and you will be able to use the buttons on it. And the 

window of Mill Mouse will be hidden.

182



Windows eye control – How to use

If you are prompted with “How do you want to open this?” when you starting the 

calibration, click Mill Mouse and then OK.
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Windows eye control – Turn off

To turn off Windows eye control and back to Mill Mouse, first select the pause 

button on the far right of the launchpad.

Then look at the upper left corner of the desktop screen. The launchpad will then 

disappear and the window of Mill Mouse will reappear.

You are now back to Mill Mouse.

※ If the taskbar is located at the top or the left on Windows 10, Windows 8.1, or Windows 7, look at the 

bottom right corner of the screen. However, if you have changed the ‘Default location of the main 

window on screen’ described on page 110 of this guide, look at that location.
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NoticesNotices

185



Uninstallation

To uninstall Mill Mouse, do it from ‘Programs and Features’ in Control Panel.

Additionally, to uninstall the sample driver you installed to use Windows eye 

control, open Device Manager and right click on the ‘EyeGazeIoctl Device’ in 

either ‘Eye Tracking Devices’ or ‘Sample Device’, and select ‘Uninstall device’.
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Known issues

 With Tobii Eye Tracker 5, it works at a very low sampling rate of around 33Hz. 

Therefore, the mouse pointer does not move smoothly.

 If you use SmartNav 4 with Mill Mouse, NaturalPoint’s SmartNav Software will 

no longer work even if you exit Mill Mouse. If you want to use SmartNav 

Software, after exiting Mill Mouse, disconnect the USB cable of SmartNav 4 

from your PC and then reconnect it.

 Even if you use the ‘Move pointer’ shortcut, the mouse pointer may not move 

where you are looking in some games.
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Restrictions and third-party notices

 Mill Mouse is a free software. Author topolo-Z is not responsible for any situation 

resulting from the use of this application software.

 The bundled gcdapi.dll is developed by Jefferson Koppe.

https://www.consoletuner.com/kbase/device_api.htm

 The bundled IrisbondAPI.dll and PGRFlyCapture.dll are from the SDK developed

by IRISBOND CROWDBONDING. S.L.

https://www.irisbond.com/en/

 The bundled QuickLink2.dll is from the SDK developed by EyeTech Digital Systems,

inc.

https://eyetechds.com/

 The bundled ViGEmClient.dll is developed by Nefarius Software Solutions e.U.

https://github.com/nefarius/ViGEmClient
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Restrictions and third-party notices

(Continued)

 Mill Mouse downloads and uses Vosk and small model language data. Vosk is 

developed by Alpha Cephei Inc.

https://github.com/alphacep/vosk-api

The licenses for each small model language data are listed at the following 

URL.

https://alphacephei.com/vosk/models

 Mill Mouse uses VMC Protocol.

https://protocol.vmc.info/english

 Mill Mouse uses oscpack according to the ‘Terms of use’ at the following URL.

http://www.rossbencina.com/code/oscpack/

 The copyright of the silhouettes of mouse belongs to FLOP DESIGN.

Author topolo-Z uses silhouette materials purchased from FLOP DESIGN.

https://www.flopdesign.com/
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Contacts to author

 Author: topolo-Z

 Mail: topolo-z@outlook.jp

 Home page: https://millmouse.wordpress.com/

https://mill-mouse.blogspot.com/
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Appendix – Shortcut keys

The following 86 types of shortcut keys are available in Mill Mouse.

 Start (Windows logo key)

 Quick Settings (Windows logo key+A)

 Show desktop (Windows logo key+D)

 File Explorer (Windows logo key+E)

 Settings (Windows logo key+I)

 Cast (Windows logo key+K)

 Lock (Windows logo key+L)

 Rotation lock (Windows logo key+O)

 Project (Windows logo key+P)

 Run (Windows logo key+R)

 Search Everywhere (Windows logo key+S)

 Clipboard (Windows logo key+V)

 Widgets (Windows logo key+W)

 Emoji (Windows logo key+Period(.))

 System (Windows logo key+Pause)

 Task View (Windows logo key+Tab)

 Maximize (Windows logo key+Up)

 Minimize (Windows logo key+Down)

 Snap left (Windows logo key+Left)

 Snap right (Windows logo key+Right)
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Appendix – Shortcut keys

(Continued)

 Voice Access (Windows logo key+Ctrl+S)

 Date & time (Windows logo key+Alt+D)

 Screen snip (Windows logo key+Shift+S)

 Hold down Ctrl key

 Select all (Ctrl+A)

 Copy (Ctrl+C)

 New (Ctrl+N)

 Open (Ctrl+O)

 Print (Ctrl+P)

 Save (Ctrl+S)

 Paste (Ctrl+V)

 Cut (Ctrl+X)

 Redo (Ctrl+Y)

 Undo (Ctrl+Z)

 Zoom in (Ctrl+Plus sign(+))

 Zoom out (Ctrl+Minus sign(-))

 Switch apps (Ctrl+Alt+Tab)

 Task Manager (Ctrl+Shift+Esc)

 Close (Alt+F4)

 Home (Alt+Home)
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Appendix – Shortcut keys

(Continued)

 Back (Alt+Left)

 Forward (Alt+Right)

 Hold down Shift key

 Help (F1)

 Rename (F2)

 Search (F3)

 Refresh (F5)

 Full screen (F11)

 Backspace key (Backspace)

 Context menu

 Delete (Del)

 Enter key (Enter)

 Esc key (Esc)

 Screenshot (Print Screen)

 Space key (Space)

 Tab key (Tab)

 Up Arrow (Up)

 Down Arrow (Down)

 Left Arrow (Left)

 Right Arrow (Right)
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Appendix – Shortcut keys

(Continued)

 Email

 Web browser

 Brighten

 Dim

 Play/Pause

 Stop

 Previous track

 Next track

 Mute

 Volume up

 Volume down

 Power

 Sleep
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Appendix – Shortcut keys

(Continued)

 Accessibility (Windows logo key+U)

 Zoom in with Magnifier (Windows logo key+Plus sign(+))

 Zoom out with Magnifier (Windows logo key+Minus sign(-))

 Turn Magnifier off (Windows logo key+Esc)

 Color filters (Windows logo key+Ctrl+C)

 On-Screen Keyboard (Windows logo key+Ctrl+O)

 Narrator (Windows logo key+Ctrl+Enter)

 Mouse Keys (Left Alt+Left Shift+Num Lock)

 High Contrast (Left Alt+Left Shift+Print Screen)

 Sticky Keys

 Filter Keys

 Toggle Keys

 Windows eye control
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Appendix – Shortcut keys

※ Quick Settings (Windows logo key+A) is only available on Windows 11. Action Center (Windows logo 

key+A) on Windows 10 is available instead. Charms (Windows logo key+C) on Windows 8.1 is available 

instead. No alternative shortcut keys are available on Windows 7.

※ Settings (Windows logo key+I), Cast (Windows logo key+K), Rotation lock (Windows logo key+O) and 

Search Everywhere (Windows logo key+S) are only available on Windows 11, Windows 10 or Windows 

8.1. No alternative shortcut keys are available on Windows 7.

※ Clipboard (Windows logo key+V), Emoji (Windows logo key+Period(.)), Screen snip (Windows logo 

key+Shift+S), Color filters (Windows logo key+Ctrl+C) and On-Screen Keyboard (Windows logo 

key+Ctrl+O) are only available on Windows 11 or Windows 10. No alternative shortcut keys are 

available on Windows 8.1 or Windows 7.

※ Widgets (Windows logo key+W) is only available on Windows 11. Windows Ink Workspace (Windows 

logo key+W) on Windows 10 is available instead. No alternative shortcut keys are available on 

Windows 8.1 or Windows 7.

※ Date & time (Windows logo key+Alt+D) is only available on Windows 10. No alternative shortcut keys 

are available on Windows 11, Windows 8.1 or Windows 7.

※ Voice Access (Windows logo key+Ctrl+S) is only available on Windows 11 since Update 2024. Speech 

Recognition (Windows logo key+Ctrl+S) on Windows 11 Update 2023 and earlier or Windows 10 is 

available instead. No alternative shortcut keys are available on Windows 8.1 or Windows 7.
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Appendix – Shortcut keys

※ Neither Maximize (Windows logo key+Up) nor Minimize (Windows logo key+Down) will work if ‘Prevent 

windows from being automatically arranged when moved to the edge of the screen’ is enabled in Ease 

of Access Center on Windows 8.1 or Windows 7. (Excluding store apps on Windows 8.1)

※ Neither Snap left (Windows logo key+Left) nor Snap right (Windows logo key+Right) will work if 

‘Prevent windows from being automatically arranged when moved to the edge of the screen’ is 

enabled in Ease of Access Center. (Excluding store apps on Windows 8.1)

※ Task View (Windows logo key+Tab) is only available on Windows 11 or Windows 10. Recent apps 

(Windows logo key+Ctrl+Tab) on Windows 8.1 or Flip 3D (Windows logo key+Ctrl+Tab) on Windows 7 is 

available instead.

※ Switch apps (Ctrl+Alt+Tab) does not work while using Windows Classic theme or High Contrast theme 

on Windows 7.

※ Rotation lock (Windows logo key+O), Brighten and Dim may not work on your PC.

※ The action when Power or Sleep is selected follows the setting of ‘When I press the power button’ or 

‘When I press the sleep button’ in Control Panel.

※ To turn Magnifier on with shortcut key, use ‘Zoom in with Magnifier’ (Windows logo key+Plus sign(+)). 

Then Magnifier will start in full screen view.

※ Narrator (Windows logo key+Ctrl+Enter) is only available on Windows 11 or Windows 10. On Windows 

8.1, it is available by Windows logo key+Enter instead. No alternative shortcut keys are available on 

Windows 7.
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Appendix – Shortcut keys

※ Color filters (Windows logo key+Ctrl+C), Mouse Keys (Left Alt+Left Shift+Num Lock), High Contrast 

(Left Alt+Left Shift+Print Screen), Sticky Keys, Filter Keys and Toggle Keys will not work if those 

keyboard shortcuts are disabled in Ease of Access Center or the Settings of Windows.

※ ‘Windows eye control’ is only available on Windows 11 or Windows 10 (since Fall Creators Update). No 

alternative shortcuts are available on Windows 8.1 or Windows 7.
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